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GETTING STARTED 

 
Please take a moment to read through the glossary to become familiar with the terms 
used in this manual. 
All Microsoft Windows updates are assumed to have been installed prior to installing 
Nevco Composer. 
 
Do not install the HASP Key until after Nevco Composer is installed.  The HASP 
Key Drivers are installed when Nevco Composer is installed. 
 

Nevco Composer CD Menu Interface 
 
Please turn off all applications running on the computer before inserting the Nevco 
Composer CD. Insert the CD ROM into its drive. If CD auto start is disabled double click 

 located on the CD. 
 
 

1. Install Nevco Composer 
2. View the Nevco Composer Manual 
3. View the Nevco Composer Manual 

VSB Addendum 
4. Browse Nevco Composer Graphics 

Browse the graphic files provided 
by Nevco per message center 
pixel matrix size 

5. Browse CD 
Explore the files on the Nevco 
Composer CD in file navigator 

6. View Message Center Service 
Manual 

7. View Any Size Message Center 
Service Manual 

8. View Message Center Installation 
Instructions 

9. View Indoor Hybrid Scoreboard with 
20mm Display Installation 
Instructions 

10. View Outdoor Hybrid Scoreboard 
with Display Installation Instructions 

11. View Full Matrix Installation 
Instructions 

12. Visit Nevco on the Web 
13. Exit 

 
 
 
 
 

Figure 1 Nevco Composer CD Menu Interface 
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INSTALLING NEVCO COMPOSER 
 
Please turn off all applications running on the computer before installing the software. 
Insert the CD ROM into its drive. If auto start is disabled, please run the StartCD.exe 
program on the CD. 
 
The NEVCO Composer Setup Wizard will guide you through the installation process. 
Follow the prompts and instructions. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 2 Initial Nevco Composer Installation Window 
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The Setup Wizard will suggest a directory location (recommended) for the program and 
support files. If you prefer a different location you may change it here. You may use 

 to help find the desired path. 
 
Note: If you specify a different path, it may be necessary to change the path settings in 
the Project Configuration dialog box after installation is completed. 
 
 

Use  to determine the disk space required and available. 
 
You can set up Nevco Composer so it can be started by anyone using this computer or 
only by you. 
 

Make the desired changes and selections then click  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3 Install Location, Access Rights and Installation Size 
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Be sure you read and agree with the License Agreement in its entirety. 
 

After reading the License Agreement click  then  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4 Nevco Composer License Agreement 
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 When you are ready to begin installing the files, click  
 
You may have to allow permissions for Composer to install during this process. 
 
 
 
 
 

Figure 3 Confirm Nevco Composer Installation 
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Select the Message Center Pixel Matrix size(s) you wish to have installed with Nevco 
Composer.  This procedure will install default projects, default playlists, and default 
graphics. 
NOTE: Your Message Center size is identified either by counting the pixels (or 
LED clusters) vertically and then horizontally. The insert in the CD case shipped 
with the message center and will have the message center matrix checked. 
 

Click  after you are finished selecting your Message Center Pixel 
Matrices. 

Figure 4 Nevco Composer Files Installation 
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Congratulations!  Your copy of Nevco Composer is now installed on your computer! 
Please remove the CD and store it in a safe location. 

 
 
 

Connecting to the Message Center 
The first step in connecting Nevco Composer to your message center is the HASP Key 
installation. 
 
Insert your HASP Key included with the Nevco Composer CD and shown below into an 

available USB port.  
 
If the “New Hardware Wizard” or “Found New Hardware” dialogs are displayed please 
refer to Appendix A at the end of this document and follow the dialog windows to 
complete the driver installation. 
 
When properly installed, a LED on the HASP key will be lit, indicating that Nevco 
Composer should be allowed to communicate with the Message Center.   
 
 

Figure 5 Nevco Composer Installation Finished 
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Setting Up the Controlling PC 
 

 The message center controller and wireless equipment (optional) are pre-configured 
to a default network configuration. The IP address of the controller is set to 
192.168.0.210. Wireless Bridge and AP are 192.168.0.211 and 192.168.0.212 
respectively.  

 When Nevco Composer is installed, the default projects are configured to talk to the 
default controller IP address. Follow these steps to set the controlling PC’s IP 
address to one that can communicate with the message center. 

1. Click the start button and select Control Panel. Navigate to Network and Internet, 
then Network and Sharing Center. Click your network card or “Local Area 
Connection,” shown in blue. Now, click on the “Properties” button. You will see 
the window on the left. Double click on “Internet Protocol Version 4 (TCP/IPv4).” 
You will see the window on the right. 

              
2. Click the Radio Button “Use the following IP address:” and enter 192.168.0.10 

and the subnet mask 255.255.255.0 and click OK on each window. You may be 
prompted to insert your Windows CD and/or be required to reboot. 

3. When you open Nevco Composer™, the button in the lower right hand corner of 
the screen should say “Update Message Center” showing that you are 
connected. (Be sure the license key is in the USB port and the LED is on.) 

4. If you are using a laptop, make sure to turn off the wireless LAN in the laptop (if 
present). This can be done on most laptops by pressing a button in the area 
above the keyboard that looks like an antenna.  Due to variances in PC 
manufacturers, please refer to your laptop manufactures manual for the 
appropriate steps to disable your wireless LAN card. 

Note: If some controls appear distorted, you may need to change the DPI setting for your computer 
screen. (Right click on your desktop, select Properties. Select Settings, then the Advanced Button.)
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Starting Nevco Composer 
 
The software install wizard placed an icon on your desktop. To start NEVCO COMPOSER, 
double-click this icon, or go to Start > Programs, and click on Nevco Composer. 
 
 

 
 
The NEVCO COMPOSER welcome screen will 
appear.  
 
A password is required. It is for your protection 
against unauthorized use of the NEVCO 
COMPOSER program. The default password is 

“Password” and is case sensitive. 

 
 
 
 
 
 
The next screen is for changing the current 
password to your own unique password. 
 
A password must be more than 6 and less than 
16 characters long. It should contain both upper 
and lower case letters as well as numbers and 
special characters such as @#$% etc. 
 
Be sure it is something you will not forget. 
 
Note: This screen will only be seen at startup 
and only while the password is “Password”. To 
change the password again click Message 
Center > (YourDisplayName) > Configure 
Password and Message Center. 
 
Registration: 
If you have not already registered Nevco 
Composer, you will be prompted, as shown to the 
right, to register each time Nevco Composer is 
opened. For 60 days, the Continue button will 
allow you to use the unregistered installation of 
Nevco Composer. 
 
Registering Nevco Composer entitles the user to a 
vastly expanding portfolio of message center 
content. Registering also allows the user to be notified of new releases adding new features. 
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The NEVCO COMPOSER control window will open next. 
 

NEVCO COMPOSER (startup screen) 
   Name of program            Name of project 

 

 
 

Indicates a failure to  
establish a connection.  
(See the Troubleshooting Chart) 
 
Note: Clicking the Connect button (available 
only if HASP Key is installed) will force an 
attempt to establish a connection to the 
Message Center.  The Message Center Status 
Bar will indicate success or failure to establish 
the connection. 
 

Message Center Status Bar – reports the following information 
for the selected Message Center: 

 Message center’s memory – total and free. 
 The message center’s pixel matrix size. 
 The firmware version. 
 Connection status 
 Error reporting or connection type 
 The message center’s reported temperature. 
 The message center’s time and date. 

 

The name of the Message Center 
selected from the drop-down box. 
The name can be changed in the 
Project > Configure Window. The 
current message center can also be 
changed in this same window. 
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Connecting the Message Center Directly To Your Computer 
 

Note: The message center and default composer software are preset to operate in this 
configuration. You need only to set your PC’s IP address as described in Setting up the 
controlling PC. 
 
The Message Center’s default IP (Internet Protocol) Address is set at the factory to: 
( 192 . 168 . 0 . 210 ). 
 
To set the Project’s IP Address to match the Message Center, in the main menu click 
Project. 
 

 
 

 
 
From the dropdown menu click Configure 
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The Project Configuration screen appears. Specify the Message Center(s) to include in this 
Project: 

 
 
 
 

 
 
 

 
 

 
  
 
 
 
 
 
 
 
 
 
 

 
Projects with large animations may require animations to be disabled to allow the composer 
computer to better utilize system resources. Verify if animations displayed in composer should 
be enabled, disabled,  
or animate on selection. Sprite viewing can be seen by the sprite or by the file name. 

 

Specify the Library category you want to have automatically opened when the project is opened. 
 

Check the Monochrome Display check box if your Message Center is  
Monochrome, otherwise un-check it for colored Message Centers. 

 

Press the “Finished” button to accept and close the dialog box. 
 
Choose the library path associated with your display 
 

Note:  On a monochrome Message Center; grayscale values may appear different than expected. 
Note:  Be sure to save your project to keep these changes in effect

Set the display size of your 
Message Center 

Note: Display will appear 
cropped on message centers that 
are smaller than the project 
Height/Width and will not fill the 
display of message centers that 
are larger. 

Click the “Refresh” or the “Refresh Table” button 
to retry connecting to the message centers listed in 
the table. 

If enabled, Composer will attempt to connect to 
the Message Center and the status of that 
attempt will be reported. 

The VSB (Virtual Scoreboard) and 
IM (Instant Message) functions can 
be enabled or disabled for 
convenience. 

Each Message Center in the table can be enabled or disabled for communications. 
(Automatically connects to Message Center). 

Each Message Center can be given a 
unique name. 

The IP Address of each Message Center 

A drop-down box allows you to choose from a list of all Message Centers that Composer has successfully 
connected to. 
If the desired Message Center address is not on the list, you can edit the default address. With the address 
displayed, click ADD to include it in the table on the right. 

One can directly connect to a message center using this 
option if the proper HASP key is installed and the display 
system is configured to do so.   
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Using the Direct Connect Configuration 

 
The Direct Connect option is an alternative to IP based connections to the message 
center. 
 
Rather than using the standard ‘X’ controller (X6 or X8) it uses a display server to 
control the message center. This means that the display is shown on the computer with 
Composer installed on it. 
 
Therefore, the Composer PC must remain on for the display to continue to display.   
 
Most displays do not need to use a direct connect option unless there is a very large 
display or a display is used to display a full matrix scoreboard using VSB.   
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When the direct connect box is 
checked note the IP option is 

disabled 

 

The message center size configuration in display 
server is done by selecting the display size in 

project configuration 
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Connecting to a Local Area Network 
 

Note: A qualified IT professional may be required to configure the Message Center 
properly for your Local Area Network.  
 
To change the Message Center’s IP Address, first establish communication between 
the computer and the Message Center as described previously. 
 
Next change the IP Address of the Message Center. In the main menu click Message 
Center. 
 
 

 
 
 
A list of Message Centers that Composer is currently connected to will appear. From this list, select the 
Message Center whose IP address you want to change. 
 

 
 

From the dropdown menu click Configure Password and Message Center 
Password and Message Center TCP/IP Interface 
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Enter your current (old) password. 
 

Enter or select the current message center TCP/IP address and click  
If the connection via TCP/IP fails, Nevco Composer will attempt to connect via the 
computers serial port (if any are available). 
 

 
 
 
Please take note of the drop down option to the right of the TCP/IP Address.  This drop 
down list contains all the valid Nevco Message Center TCP/IP addresses that this copy 
of Nevco Composer has connected with successfully. 
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You can now change: 
A. Message Center IP Address 
B. Message Center Subnet Mask Address 
C. Message Center Gateway 
D. Message Center Firmware 

(Be aware that if your current message center height and width does not match the 
open project, you can misconfigure the message center) 

 
Press the Update TCP/IP Settings button to apply the new message center address. 
 

 
 
 
“Upgrade Message Center Software” will upgrade the firmware and configure the 
message center with the selected configuration file. 
 
 
 
The release notes included with your Composer upgrade will identify if a firmware 
upgrade is necessary. 
 
Then press OK to close the dialog box
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Nevco Composer Overview 
 

Please see the Glossary near the back of this manual for more clarification of terms. 
 
Nevco Composer allows the user to compile, or put together, graphics and text messages 
(Playlists) for display on the message center. It also provides a way to schedule the times and 
dates the Playlists will be displayed. Playlists can also be set up as Instant Message Playlists so 
that they can be played instantly with the touch of a button. 
 
The Frame is the basic display element for the message center. It represents the face of the 
message center and provides a work area for the placement of graphic and text items. All items 
to be displayed must be on a frame. Each frame includes a set of attributes that define how it is 
to be displayed on the message center. 
 
A Playlist is a group of one or more frames that make up a complete graphic or message 
sequence. Each playlist can include a time and date schedule when it will be displayed 
automatically by the message center, or it can be designated as an instant message playlist that 
can be displayed instantly with a single mouse click. 
 
A Project is a group of one or more playlists. The memory in the message center can store one 
project at a time. When a new project is sent to the message center the old project is erased. 
Each project needs to include all scheduled and instant message playlists needed to complete 
the event. Only the size of your hard drive limits the number of projects that can be stored on 
your computer. These can be loaded into Nevco Composer and sent to the message center 
when needed.  
 
The following graphic formats can be imported into Nevco Composer for display on the 
Message Center: .bmp, .gif, .jpeg and .avi. 
Note: avi. files can be encoded using a “codec” from a third party provider. This codec must 
reside on your computer in order for you to decode the video. 
 
Complete playlists can be converted to an animated .gif file. You can then drag and drop it onto 
a single frame in another playlist. 

Pre-Configured Projects 
 

A project has been created for each of Nevco’s standard message center sizes. You can open 
one of these projects and begin from a sample project for your message center. 
 
Each time Composer is started, a new blank project is started. You may begin creating 
messages in this new project, or, you may open one of the pre-configured projects for your size 
of message center (recommended) and modify it for your needs.  
 
Note: Be sure to use “Save As” to name the modified project a unique name so the pre-
configured file is not overwritten. Create a shortcut to your project to launch right from your 
desktop.  Nevco Composer will open the project file called “Default”   by default.
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Nevco Composer Tutorial 
 
The Nevco Composer user interface is divided into three main sections: 
 
 
Sprite Library 

The Sprite Library section displays the sprites (graphics or text icons) available for 
placement on a frame. Several library categories are available to help in organizing 
display library items. You can also create your own custom categories. 
  
 

Playlists 
The Playlists section shows a tab for each playlist in the current project. When you 
select a playlist (click on its tab), the frames it contains are displayed in the center 
section of the user interface screen. If there are more frames than will fit in the allotted 
space, a scroll bar will allow you access to any frame in the playlist. When you select 
(click on) a frame, its presentation attributes are displayed in the Frame section of the 
Message Center Controls screen on the right. A playlist can be previewed by clicking the 
play button that appears to the left of the playlist name on the playlist tab when it is 
selected. The preview window will open and the frames of the playlist will be shown as 
they will appear on the message center. 
 
 

Message Center Controls 
The Message Center Controls are divided into three main sections: 
Library 

Create Text sprites, Scrolling Text sprites, import Graphic files, select Tokens 
for date, time, and temperature, or Virtual Scoreboard, and add them to the 
display library. (For Virtual Scoreboard see the NEVCO Sports Composer 
Addendum or contact the NEVCO Sales Department). 

Frame  
Specify how the frame will be displayed on the message center. You can specify; 
the Effect (transition) used to make the frame initially appear, the Effect Speed 
(how fast the transition takes place), the Frame Duration (length of time the 
frame remains on the message center after its transition is completed), and the 
Frame Repeat (number of times the sequence will be repeated. Drag and drop 
display items from the library onto frames and position as desired. 

 Playlists 
Set the Schedule (start and stop time) for the selected playlist, or designate it as 
an Instant Message Playlist (to be played on demand from the Instant Message 
Interface). You can also specify a section or Zone on the message center where 
the selected playlist will be displayed. 

  
 

Playlists are grouped together to form a Project. When you click the Update Message Center 
button the complete project is sent to the Message Center, and replaces the old one. In addition 
to scheduled playlists, the project can contain Instant Message Playlists. Once sent to the 
Message Center, these unscheduled messages can be displayed on the Message Center 
instantly from the Nevco Instant Message Interface. Just click the icon that represents the 
instant message of choice. Any scheduled playlist being displayed will be interrupted while the 
Instant Message Playlist is displayed. The interrupted message will begin playing again from its 
beginning. 
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Nevco Composer User Interface (sample screen) 

 
Start the sample project 

From the main menu bar, click File, then choose Open. 
Find and open the sample project for your size of Message Center. 
 
Note:  This sample project can be modified to your needs, saved under a 
different name and used as the basis for creating other projects you may need.  
 

 
 

Sample Screen (typical) 
 
 
 
Note:  Sprite Library items, either text or graphic, shown in this manual are for 
illustration purposes only and does not imply that they are included as part of the 
software package.
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Save Project As 
 Click File, then Save Project As 
  
 

 
 
 
 
 Type “Tutorial” and click Save. 
 

Note: Use “Save Project As” to apply a new name to the project at the beginning 
to eliminate the danger of overwriting an existing file.  
Be sure to save your changes before exiting the program. 

 
You will be presented with another Save As dialog box for the Default Playlist. 
Type “Tutorial PL” and click Save. 

 
Create a Shortcut 

To go straight to your project file each time, you may create a shortcut and place 
it on your desktop by following these steps: 

a. Click File > Open 
b. Right click on the project file you wish to open from your desktop 
c. Select “Create Shortcut” from the menu 
d. Drag and drop the shortcut on your desktop 
e. Hit cancel on the Open dialog menu 
f. This can also be done through windows explorer if you are familiar with it 

 
Save Your Changes 

After your project file has been created, save changes with “Project > Save”, “File 
> Save Project”, or the “Ctrl + S” shortcut. 
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Check the Frame and Playlist settings, then send the message to the message center. 
 

 
  

Check each Frame’s attributes. 
 
 Check the Playlist area to make sure the 

playlist is scheduled to be displayed. 
 

Click the Update Message Center button. 
 
 
 
Congratulations! You have displayed a playlist on the message center. 
 
 
 
 
We highly recommend that you experiment with the numerous settings and options 
available, and become familiar with all that the message center can do. 
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Managing Graphics (Sprite Library Items) 
Several categories have been included for organizing Sprite items. You can also 
add more categories as needed using the “…” option. 
Click on the drop down arrow for the categories list box. Locate the item named 
“…” and click on it. 
 

 
 
 

The Browse for Folder dialog box opens. 
  

The current library folder is selected. Click on  
 this folder to expand it. 
 
  Click the “Make New Folder” button.  
 

Notice a new file “New Folder” has been added. 
 
To rename the new folder, right click on it to select  
it and to open the right click menu. 
 
From the right click menu choose “Rename”. 
 

 Type the desired name then press “ENTER” on the 
keyboard. 
 

Click the “OK” button to close the dialog box and return to 
the main Composer screen. 

 
Note: For better performance; use more categories with fewer 
sprites in each. (Fewer sprites visible in Sprite Library at once.)  
 
To add an existing sprite to another category: 
 (a) Select the sprite. (Puts a copy in the Library work area.) 
  (b) Select the new category.                            (c) Click “Add To Library”  

 
Note: Deleting a sprite from its 
original category will affect all 
playlists that used it. 
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Adjusting the Size and Position of an Image or Sprite 
The following screen shots demonstrate how to resize and reposition a sprite on a 
frame. 
 
We will use the NEVCO sprite to design the message as it will appear on the message 
center. 
 

 
 
Left click on the Nevco Sprite. 
Drag it to the frame and drop it there. 
 
 

 
 
 

Click on one of the corner handles and drag to resize 
the sprite. This will maintain the aspect ratio. 

 
If you click and drag a center side handle, it will stretch the sprite in that direction. 
 
You may also use the “+” or “-” keys on the numeric keypad to adjust the size of a 
sprite. Each press of the key increases or decreases the size of the sprite while 
maintaining the aspect ratio.  
 
 
Note: For best results with text sprites, start by selecting the appropriate font size. 
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To Position The Sprite: 
 

 
 
 
 
Left click in the center of the sprite to select it. 
 
Left click and hold to drag the sprite to the center of the frame. 
 

 
 
 
You can also center a sprite on its frame by right clicking on the sprite and from the right click menu 
choose “Center Selected Sprite”. 
 
Another way to center a sprite is to select it, then 
click the “Center Selected Sprite” button on the 
Frames attribute area. 
 
 
 
The keyboard can also be used to position a sprite by using the four arrow keys “←”, “→”, “↑”, “↓”. If 
you hold down the “Ctrl” key while using an arrow key the selected sprite will be moved to that edge 
of the frame. 
Press “Ctrl + Shift + C” to center a selected sprite on the frame. 
 
Note: If you drag a sprite off of the frame, it is removed from the playlist area and can be obtained 
again from the library. 
  
 

Use your imagination and be creative. 
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NEVCO COMPOSER (user interface) 

 
Sprite Library Playlist Message Center Controls 
 
This section is 
used to display text 
and graphic items 
that are available to 
drag and drop onto 
a frame. Sprite 
library items can be 
stored in categories 
for easier 
searching. To add 
new items, use the 
“Library” section to 
the far right. 

 
The playlist section shows all playlists in the 
project. Click on a playlist tab to reveal its 
display schedule or instant message status 
and to display all of its frames. The frames 
will be displayed on the message center in 
the same order they appear in the playlist. 
The “frame” is the basic display element for 
the message center. All text and graphics to 
be displayed must be on a frame. Frames 
can be added to or deleted from a playlist 
and playlists may be saved as a new 
playlist or used to replace an existing one. 
When all frames in a scheduled playlist 
have been displayed, the sequence starts 
over. If more than one playlist is scheduled 
for the same time period, they will be 
displayed in sequence. A “play” button 
located on the selected playlist’s tab can be 
used to preview the playlist as it will appear 
on the message center. 
The frame order can be altered by first 
selecting the frame. Then use the “Ctrl” + 
arrow keys to shuffle it up or down.  
Note: You can use the arrow keys by 

themselves to move selection from frame to 
frame. (This is especially handy if you want 
to move a frame that is completely covered 
by a sprite. Select any frame, or insert a 
new frame then use the arrow keys to move 
the selection to the covered frame). 
Note: A frame’s border is blue/aqua when it 

is selected and it is not empty; Purple-gray 
indicates a selected empty frame. 

 

This section is divided into three main parts, “Library”, “Frames”, 
and “Playlists”. 
The “Library” section is divided into four parts, the Text tab allows 
you to create or edit a text sprite, define its characteristics, and 
add it to the sprites in the Display Library list. The Scrolling Text 
tab is for creating text strings that are to be scrolled across the 
message center. You can preview, change attributes, edit, and 
add to the sprite library. The Graphics tab allows you to import a 
graphic and add it to the library. The Token tab is for 
Date/Time/Temperature (requires a temperature sensor to be 
installed at the Message Center). Another tab, “Virtual 
Scoreboard” is used in Nevco SPORTS Composer which allows 
live scoreboard data to be displayed on the message center. (See 
the Nevco Sports Composer Addendum or contact the Nevco 
Sales department). 

 The “Frame” section allows you to define how the message 
center displays each frame. You can choose from many “Effects” 
(transitions). You can set the speed of a transition, duration 
(number of seconds the frame remains displayed after its 
transition is complete), and number of times the sequence is 
repeated. You can also select the background color of the frame 
and toggle the background color of the sprite on and off.  

The “Playlists” section allows you to specify when a playlist will be 
displayed on the message center. It’s like setting your DVR to 
record a program or series of programs.  Playlists can be 
designated as “Instant Message Playlists”. These playlists can be 
displayed on demand from the Nevco Instant Message Interface. 

An additional area near the bottom includes a button that sends 
the complete Project (Scheduled Playlists and Instant Message 
Playlists) in the Playlist work area to the message center for 
display. Another button will open the Nevco Instant Message 
Interface where you can easily and quickly select an Instant 
Message Playlist and immediately display it on the message 
center. 
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Sprite Library 
 

  
 
 

Playlists and Frames 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Frames 
The Frame is the basic display element for the Message 
Center. All text and graphic items to be displayed must be 
on a frame. Each frame represents the face of the message 
center. You can drag and drop a sprite from the sprite library 
onto a frame. During the initial placement of the sprite, the 
frame has “snap to edges” which make it easy to drop the 
sprite at any of the frames four edges. Once you drop the 
sprite, the edge alignment is turned off and you can left click 
and drag a sprite to the desired location, including part on 
and part off of the frame. You can also use the arrow keys to 
relocate the sprite, or use “Ctrl” + an arrow key to move the 
selected sprite to that edge of the frame. You can center a 
sprite with “Ctrl + Shift + C”, by using the right click menu, 
or with the “Center Selected Sprite” button. To resize a 
sprite, select the sprite, then, with the cursor in its lower 
right corner, left click and drag as desired. Or use the “+” or 
“-” keys. 

Frames can be manipulated in a variety of ways; select a 
frame, then, right click for a list of options to choose from.   

 Note: If you save a frame, it is added to the current 
category of the sprite library along with its graphics and 
text. 

Playlists 
A project consists of one or more Playlists. 

A playlist consists of one or more frames.  

To add another playlist to the project, right click in the 
playlist tab area for a menu of options. Choose Add Playlist. 
A new playlist is added to the work area. It has a generic 
name and an “*” to indicate that it has not been saved. 

You can rename a playlist to make it more recognizable. 

You can also convert a playlist to an animated .gif file 
(sprite) for use in other playlists.  

Playlists can be scheduled for display at certain times, or, 
designated as an instant message playlist for instant selection 
and display. 

Click the “play” button on the tab of the selected playlist to 
see a preview of the playlist as it will appear on the message 
center. 

Note: An “*” at the end of a playlist’s name indicates the 
playlist has not been saved. 

 

 
 
 

Sprite Library 

The Sprite Library shows the graphic and text sprites in the selected category. This can display in two different ways: sprite view or text view. Sprite view 
is shown on the left and shows the sprites in a visual manner. Text view can be seen in to the right of the sprite view library. Text view displays the sprites 
by their file names. You can see that the names seen here are coordinated with the sprites images shown to the left.  

From the sprite library, these sprites can be dragged to and dropped on one or more frames in the project. Once on a frame the sprite can be resized and 
repositioned. 

To delete a sprite from a frame, select the sprite and press the DELETE key. 

To remove a sprite from the sprite library: select the sprite, right click to display a special menu, then click Remove Sprite From Library. The following 
dialog box appears.  

 
To permanently remove the sprite from all frames, playlists, categories, and projects, click OK.   

Click Cancel to return to the work area with no change to the sprite. 

 

 
 
 
 
 
 
 

The frame order can be altered: First select the frame then use the “Ctrl” + arrow keys to 
shuffle it up or down. Note: You can use the arrow keys by themselves to move selection 
from frame to frame. (This is especially handy if you want to move a frame that is completely 
covered by a sprite. Select any frame, or insert a new frame then use the arrow keys to move 
the selection to the covered frame). 
Note: A frame’s border is Blue when it is selected and it is not 

empty; Blue-Gray indicates a selected empty frame. 
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Library:  

 

  

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
Frame: 

 
 
 
 
 
 
 
 
 
 
 
 
 

Playlists: 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Text Tab 
Allows you to enter or edit a word or phrase for display on the message center.  
Choose the Font, Font Size and Color, and Background Color, then click “Add to 
Library” or “Update Library Item” if you are editing a library text sprite. 
Scrolling Text Tab 
Allows you to enter text strings to be scrolled across the message center. You can 
adjust the scroll speed and the vertical position as well as specifying the font. A 
preview screen shows how the string will appear on the message center. 
Graphics Tab 
Allows you to import a graphic image or AVI file and add it to the Display Library 
where it can be drug onto one or more frames. A “Crop and Zoom” utility helps 
when working with graphics. 
Tokens Tab 
Allows you to create a Sprite that can be placed on a Frame and will cause the 
Message Center to display the Date / Time / Temperature. (Temperature requires 
additional optional equipment at Message Center) 
Virtual Scoreboard Tab 
Allows you to select or edit a virtual scoreboard. (See the Nevco SPORTS 
Composer addendum or contact the Nevco Sales Department.) 

The Frame section allows you to specify how a frame will be displayed. 
You can choose from several effects (transitions). You can set the transition speed, 
the duration (number of seconds the frame will linger after the transition is 
complete), and frame repeats (number of times the sequence will be repeated). 
You can set the frame’s background color and show or hide a sprite’s background 
color. You can even display a representation of the pixel grid for the selected frame 
or sprite. 
You can use the “Center Selected Sprite” button to center a sprite on a frame. 

Schedule Tab 
Allows you to specify when a “Playlist” will be displayed by the message center. (Once a scheduled playlist has been sent to the message center it will be 
displayed according to its schedule even if the computer running Composer is turned off).   If more than one playlist is scheduled for the same time frame they 
will be displayed alternately. 
You can set the playlist to be displayed on weekdays, weekends, or both, or you can pick from the days of the week. You can display the playlist all day or set 
the start and end time. You can even set a beginning and ending date during which the playlist will be displayed. You can disable the playlist from being 
processed/sent to the message center using the Disable Playlist check box. 
The Instant Message Playlist check box allows you to designate any scheduled playlist as an Instant Message Playlist.  Once sent to the message center, an 
instant message playlist can be displayed on demand from the Nevco Instant Message Interface. (The computer running Composer must be connected to the 
message center).  Any running scheduled playlist will be interrupted by the instant message playlist, after which the interrupted playlist will resume from its 
beginning.   
 
Zone Tab 
Allows you to specify a portion of the message center to be used by the selected playlist. 
Note: Changing the message center size will cancel any and all previously set zones. 

Click the Update Message Center button to send a copy of the project 
and all of its playlists and their frames, effects, and settings to the 
message center. 
 
Click the Instant Message Interface button to display a screen that 
shows an icon for each Instant Message available. Click an icon to 
display the Instant Message.  
 
NOTE: the Instant Message Interface is only available after a 
successful Message Center Update is complete and if Instant Message 
Playlists are included in your project. 
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MESSAGE CENTER CONTROLS 
 

Library Items 

This part of the Message Center Controls allows you to add or update library items. 
There are four types of library items, Text, Scrolling Text, Graphic, and Token.  

 
 
 

Text 
Pressing the Text tab allows you 
to create or edit a text string and 
add it to the sprite library. 
 
You can: 

 Enter or edit text 

 Select the font and font size 

 Set the font color 

 Set the background color 

 Set the text alignment 

 Set the sprite file name 
 

Note: Foreign language fonts can be selected and used in text items.  
Note: For more information see the section “Text Message Help” near the back of this 
manual.  
 
 
 
 
Scrolling Text 

Pressing the Scrolling Text tab allows you to create or edit a text string to be 
scrolled across the message center. After editing text, press enter or click the 

refresh button if needed.  
 

You can: 

 Enter or edit text 

 Choose the font 

 Set the alignment 

 Set the speed 

 See a preview 

 Update a sprite 

 Name the sprite 

 Add a sprite to the 
sprite library 
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Graphics 

Pressing the Graphics tab allows you to add a graphic or .avi file to the Sprite 
Library. 

Click  to open a dialog box and pick the graphics file of choice.  
 

 
You can: 

 Import a graphic 
file 

 Import an .avi file 

 View a likeness of 
the graphic or 
video clip 

 Crop and zoom 
graphic images 

 Name the sprite 

 Add to library 

 
 
Crop and Zoom 

 
 
 
 

Crop and Zoom  Tools 
 

 A cropping frame 

 A zoom slider bar 

 The ability to directly enter the pixel size of 
the crop area 

 A button that matches the cropping area to 
the frame 

 Specify the X and Y location of the start of 
the crop area 

 Crop & Finish button  (closes the utility) 
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The following screen shot shows the result of the use of the Crop and Zoom utility to 
help create a playlist of players from a group picture. 
 
 

 
 
 
 
 
 
 
 
Note: If an error occurs when trying to import an .avi, .mp4, or .wmv file, it may be 
because the proper video decoder or “codec” is not installed on your computer. A four 
digit code in the corner of the error box identifies the codec needed to properly decode 
the file. The codec may be available for free or at some fee by the provider. Nevco Inc. 
makes no guarantee as to the level of success a user may have by installing third party 
software. 
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Tokens 
Pressing the Tokens tab allows you to add a token for time, date, or 
temperature, to the library item list. The difference between a token and text is 
that the message center will update the token text with live data. If you created 
text “December 1, 2016” it would never change from the date that you typed. A 
token on the other hand, will always display the current message center date. 

 
You can: 

 Select a format for 
displaying the time, date, 
and temperature 

 View a likeness of the 
data 

 Select the font size 

 Set the font color 

 Update a library sprite 

 Add to sprite library 

 Change the text 
alignment 

 Name the token 

 
 

 

 

Virtual Scoreboard 
 
Virtual Scoreboard is live scoreboard data from a Nevco MPC Operators Control, 
being displayed on a Nevco Message Center, as if on a scoreboard. 
 
Please Note: This feature requires a Nevco SPORTS Composer license.  
 
For more information about Virtual Scoreboard see the Nevco Sports 
Composer Addendum or contact the NEVCO Sales Department. 
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Frame 

This section allows you to define how the message center will display each frame. 
 
 
 
 
 
 
 
 
 
 

 Effect Defines how the frame transitions onto the message center. 

 Effect Speed Defines the speed of the transition. 

 Frame Duration How long the message or graphic will linger after the transition 
is completed (accepts decimal values). This will mean that for animated graphics, 
the last frame will display until time is reached. For animated graphics, this can 
be set to 0 and that will cause the graphic to display in full and then move on 
when finished. 

 Frame Repeats Specifies the number of times the sequence will be repeated 
before moving on to the next frame. 

 Center Selected Sprite Moves a selected sprite so it is centered (both 
horizontally and vertically) on the frame. 

 Background Color Opens a dialog box for selecting the background color for 
the selected frame. 

 Frame Type Reports the type of data on the selected frame. 

 Draw Sprite Background(s) When checked, adds the color of the sprite 
background to the frame. 

 Show Selected Frame’s Grid When checked, displays the pixel grid of the 
frame; helps in placement of the sprites. 

 Show Selected Frame Sprite(s) Grid When checked, displays the sprite’s grid.
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Playlists 

This section allows you to set the times when a playlist will be displayed on the message 
center. The criteria stays with the playlist and can run automatically (like setting a DVR to 
record a show.) 

 Instant Message Playlist (Live) radio button, designates the selected playlist as an 
Instant Message Playlist or Live Playlist, clears all scheduling for it and turns the 
playlist tab and border color to green 

 Disable Playlist radio button, clears all scheduling for the 
playlist and turns its tab gray, can be useful for a playlist that 
you do not wish to display, but want to keep in your project for 
use at a future game or date 

Schedule 
Selecting the Schedule tab 
allows you to set the days and 
times the selected playlist will 
be displayed on the message 
center. 

 
You can set the days: 

 Play All Weekdays 

 Play All Weekends 

 Choose from a list of  
the days of the week 
 

You can set the time: 

 Play All Day 

 Set the Start Time 
and the Ending Time 

 
You can set the Date: 

 Set the Start Date and the Ending Date 
Zone 

Selecting the Zone tab 
allows you to specify a part of 
the Message Center that will be 
used for the selected playlist. 
The rest of the message center 
will remain unchanged. This 
advanced feature can be useful 
if you wish to combine things on 
the display that don’t normally 
allow combining. Such as time and temperature on the top and “Brought to you by:” 
on the bottom. The message center will play the active playlists in order. So on a 
48x144 message center, if you zone Playlist 1 at 0,0 with a size 24x144 and drop the 
time and temperature on a frame positioned at 0,0. Then set Playlist2 to 0,24 with a 
size 24x144 and drop a logo or text at location 0,0. The two items will be spliced 
together on the message center as one. 
 
Note: Changing the message center size will cancel any and all previously set.
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Update Message Center 

 
 
Click the Update Message Center 
button to send the project to the 
message center. It will replace the 
old one and the new message(s) will 
begin being displayed (subject to 
scheduling). 
  
 
Click the Instant Message Interface button to open the Nevco Instant Message 
Interface. 
This screen allows fast easy selection and display of these special unscheduled 
messages. Just click on the icon of choice. 
 
Note:  The Instant Message Interface button is available only if at least one Instant 
Message Playlist has been sent to the Message Center using the Update Message 
Center option above. 
 
 
 
If the HASP Key is not installed you will see a different view of these controls: 
 

 
 
 
 
If the HASP Key is installed and either Auto Connect is disabled, or Nevco Composer 
cannot connect to the TCP/IP address specified in Project > Configure: 
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Instant Message Playlists 
 
Any playlist can be turned into an Instant Message Playlist. 
 
Click on the playlist tab to select it. 
 

 
 
Click the Live radio button to designate the selected playlist as an Instant Message 
Playlist. 
The playlist tab and border will turn green.  
 
Click the Update Message Center button to send the complete Project including the 
Playlists and Instant Message Playlists to the message center. 
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Instant Message Interface 
 
Once the project has been sent to the message center and if there are any Instant 
Message Playlists in the project, you can click on the Instant Message Interface button 
to open the Nevco Instant Message Interface. There may be a slight delay before the 
button becomes available to press following an update due to loading of the instant 
messages. 

 
 

 
 
 

 
 
 
 
 
 

 
The Nevco Instant Message Interface will contain icons representing each Instant 
Message Playlist in the project. Each of these icons will display what that instant 
message will display if selected with a left click.   
 
Any scheduled playlist running will be interrupted. After the Instant Message Playlist is 
completed, the interrupted playlist will restart at the first frame, and will be played in its 
entirety. 
If “Disable All Animations” or “Animate on Selection” are selected in project 
configuration, the icons in the instant message interface will only display the first still 
frame of the instant message playlist. To animate these icons one can right click on the 
desired icon to open up a menu to play or pause those icons. 

 
 

 
 
Note: If the Nevco Sports Package is purchased the instant message interface will be 
changed into “Game Time Interface”.  Instant message operation will be the same and 
any changes will be described in the VSB Addendum.    
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The Right Click Menus 
 
Project Configuration 

  
 
 
Sprite Library Section 
  

Select a sprite in the Sprite Library section, then, right click on it to open the 
following menu. 
 

 
 
 

 

To permanently remove the sprite from all frames, playlists, categories, and projects, 
click OK.   

Click Cancel to return to the work area with no change to the sprite. 

 
 
Playlists Tabs Section 
 
 Select a playlist’s tab, then, right click on it to open the following menu. 
 

 
 
 
 
 
 

Adds another playlist to the project. 

Duplicates the selected playlist. 

Deletes the selected playlist. 

Allows you to add audio to the first frame of the playlist. 

Allows you to rename the selected playlist. 

Creates an animated .gif (sprite) from the frames in the selected playlist and adds 
it to the sprite library work area and to the current category. 

Saves the selected playlist. 

 

Saves the selected playlist and all of its current frames. (clears the “*” that 
indicates an unsaved playlist). 

 

Left click this menu item to remove the sprite; the following dialog box will 
appear. 

Left click this menu item to refresh the current status of the selected message 
center 
 
Remove the selected message center from the table 
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Frames Section 
 
 
 Select a frame, then, right click on it to open the following menu. 
 Or right click in the frames open work area to open the menu. 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
Popup Information Boxes 

If you hover or pause the mouse on certain items an information box will appear with 
useful information. 

 
Sprite Library 

Hovering over an unused portion of the library area will provide a count of the 
sprites in the selected category. 

 
Frame 

Hovering over an unused portion of a frame will provide a count of the sprites on 
the frame. This is helpful if some sprites are hidden by others.

Adds another frame to the bottom of the playlist. 

Inserts a frame above the one selected. 

Deletes the selected frame. 

Saves the selected frame and its contents to the sprite library area as an image. 

Makes a copy of the selected frame and its contents and places it immediately 
above the original. 

Moves the selected sprite to the center (both vertically and horizontally) of its 
frame. 

Moves the selected object to the front so no other objects are covering it. 

Moves the selected object to the back so it does not cover any other objects 
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The Main Menus 

 
In the top left section of the user interface you will find drop down menus for file management, user 
preferences, and special information.  

File  

New Starts a new project from scratch 

Open Opens an existing project 

Import Playlist Makes it easy to add a saved playlist into your 
current project 

Save Project Saves changes to the current project 

Save Project As Saves the current project to a new name. 
(You will be prompted with the Save As dialog box for each 
playlist in the project) 

Save Playlist Saves changes to the current playlist 

Save Playlist As Saves playlist with a new name 

Save All Playlists Saves changes to all playlists 

Exit Close Nevco Composer 

A list of the last four project files opened will be displayed and can be clicked to open them or the 
shortcuts listed can also be used. 
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Project 

New Starts a new project from scratch 

Open Opens an existing project 

Save Saves the current project 

Close Closes the current project 

Configure Opens a dialog box that allows you to specify 
multiple message centers and the criteria and file 
paths for the active project 

 
 
 

Display Size – Associates the project (software) with the physical size of the Message Center. When  

Composer connects to a message center and the size does not match these settings, a pop-up 

will notify you of the conflict. Answering yes will set these values to the size reported by the 

message center. 

Monochrome Display - Associates the project (software) with the color (type) of the Message Center. 

Check the box for monochrome; uncheck it for color. 

Note:  On a monochrome Message Center, grayscale values may appear different than 

expected. 

 Display Connection - Sets the project (software) to the IP Address of one or more Message Centers. 

Note: Click the drop down arrow to see a list of all valid Nevco Message Centers that this copy 

of Nevco Composer has successfully connected to. Use the ADD button to add a message 

center to the table. 

Note: You can right click on a message center in the table to open a menu that allows you to 

remove it or to refresh its current status. 

The table helps in managing multiple message centers: You can enable or disable as well 

as name the message center and monitor the connection status of each. You can also restrict or 

allow use of Instant Message Playlists and Virtual Scoreboard Playlists on the Message Center 

and in the Game Time Interface. (See the Nevco SPORTS Composer Addendum or contact the 

NEVCO Sales Department.   

 Default Project View - Allows you to set the default library when Nevco Composer opens this project. 

Default Library View - Allows you to set the default library view when Nevco Composer opens this  

project. This can be visual (spirte view) or alphabetically by text file names (text view). 

 Library Path - Allows you to change the path where the library items (sprites) are stored. 
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Edit 

Add Adds one of the following 
elements: 

  New Playlist 
  New Frame 
 

Rename Playlist Saves a copy 
under a new name 

 
Delete Playlist Removes the 
currently selected playlist 

 
Delete Frame Removes the currently selected frame 

 

View 

Zoom Allows you to adjust the work area to 
show more detail or to show more items, can be 
adjusted to your desired zoom level as seen 
 
 
 
 
 
 
 

 

 

Message Center 

 
 

Choose from the list of currently connected message centers, then, choose the function you want 
to change.
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Brightness Interface 
 

(Must be connected to the Message  
Center) 
Reports the current brightness level of 
the message center and allows you to 
select how the message center’s 
brightness level is controlled (manual or 
auto). 

 
Manual mode lets you set the brightness 
level of the message center directly. 

 
In Auto mode the “Photocell Level” 
reports the value measured by the photo 
sensor. (Requires a photo sensor 
installed at message center).   

 
The “Auto Light Sensitivity Adjustment” 
slider lets you adjust the amount of 
change in brightness that is caused by a 
change in detected light. 

 
Note: Use the auto mode only if there is a photo                                                                                                                   
sensor installed on the message center. 

 
Temperature Interface 

 
(Must be connected to Message Center) 
Allows you to enable or disable the 
Message Center’s temperature sensor if 
so equipped.  

 
Also allows a calibration adjustment for 
temperature sensor location. This means 
that if the temperature sensor is a few 
degrees off, it can be calibrated to be 
correct.  

 
 

Reset 
(Must be connected to Message Center) 
Resets the message center. 
Reboots the message center controller.  
Starts playing scheduled playlists from the beginning.  

 
 

Configure Password and IP Address 
Explained on pages 16 and 17. 
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Configure Time and Date 

(Must be connected to Message Center) 
When the dialog box opens, the PC’s current time and date is fetched and displayed on 
the left side. The message center’s time and date is displayed on the right side and is 
continually being updated. 
To set the message center’s time and date; make the necessary adjustments on the left. 
Be sure to check the “Enable Auto DST” for U.S. Daylight Saving Time check box if 
desired.  
Click the “>> SYNCHRONIZE >>” button to send the new settings to the message center. 

  

 
 

Click EXIT to close the dialog box. 
 
 
 
Log 

(Must be connected to Message Center) 
The log keeps track of what has been displayed on the message center and when. 
 
Note: To maintain accuracy of the log files, use a unique name for each playlist. 
 

 
 
When you click on the log option, these menu items are available. 
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Sequential 
The size of the files can be set and 
an index number indicates the 
location of the most recent entries. 

 
Event Log 

The event log creates an 
entry each time the 
message center’s power is 
turned ON or updated. 
 
The “Export To Comma 
Separated File” button 
creates a file on your 
computer that can be 
imported into another 
program for detailed 
analysis. 

 
Playlist Log 

The playlist log creates an 
entry each time a playlist is 
displayed. 
  
The “Export To Comma 
Separated File” button 
creates a file on your 
computer that can be 
imported into another 
program for detailed analysis. 
 

 
 
Note:  Playlist duration times could deviate +/- 1 second due to synchronization of 
playlists displayed on the message center. 

 
 

Playlist Run Time 
This log report shows the name of the 
playlist. 
 
The number of times the playlist was 
displayed on the message center. 
 
And the total length of time it was 
displayed. 
 
The “Export To Comma Separated 
File” button creates a file on your 
computer that can be imported into 
another program for detailed analyses.
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Configure 

Allows you to set the size of the log files. 
 

Click “Apply” to make these changes take 
affect. 

Note: This will clear all log data. 
 

Reset 
Clears the log files of all data. 
 

 
 

Pixel Configuration Utility (Pixel Editor) 
The pixel editor can be used to adjust the intensity of each LED in each pixel in the message 
center. This utility should rarely be needed and should be used only by someone familiar with 
the message center. 

 
Note: Requires Message Center Firmware 1.81 or Later. 

 
Please see appendix B for details.  

 

Help 

 
Contents 

Displays the complete set of operating instructions in PDF format. 
 

About 
Displays information about Nevco Composer including the version number and build date/time 

 
Documentation 

Provides easy access to user documentation, installation instructions, and service 
documentation. These are the same files that can be found in the CD interface. 
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General Information  

Network Integration  

Nevco message centers are delivered pre-configured to an IP address so that when the 
software is installed and the PC is given an IP address, the message center will be connected. 
Since network topologies and address schemes vary, your IT personnel are the best 
candidates to integrate a message center onto your network. Just like a printer or any other 
network device, the message center IP address and subnet mask can be configured. See the 
section Connecting To A Local Area Network. This section provides some general information 
about networking message centers. 

 

10/100Base-T Ethernet Connectors 
 

             
 
 

Customer’s Network Today 

 

On Solid – 
Plugged in 

Blinking – 
Sending or 
Receiving Data 

Network Symbol 
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A word about IP addresses: 

 An IP address is the “phone number” in network lingo of the Ethernet Jack. 

 Format is xxx.xxx.xxx.xxx where xxx is from 0 to 255. 

 Subnet mask portions IP address into “(area code) phone number”. PC’s have to 
have the same area code to communicate without a router. Subnet mask is same 
format as IP address. 

IP address  Subnet Mask Area Code # PC’s in 
network 

192.168.0.1 255.255.255.0 192.168.0 256 

192.168.0.1 255.255.  0  .0 192.168 65535 

 Don’t freak out! The IT guy at your institution or our service department can help. 
Just know they exist and it’s the one thing that needs to be set to fit customer’s 
network infrastructure. 

 The message center does not support DHCP, which is automatic IP address 
assignment. 
 
 

Customer Configurations 

 
 
 
Customer 
will want to 
control 

From PC Special IT Requirements 

I.  A 
1. Set PC IP address to 192.168.0.xxx; where xxx is anything but 1. 
2. PC ‘A’ must have an Ethernet Port. 
3. Install 2nd network card if PC is on a LAN. 

I.  B 1. PC ‘A’ must have packet forwarding software. 

II.  A or B 1. Message Center IP address set to fit customer’s LAN. 

II.  C 
1. Message Center IP address set to fit customer’s LAN. 
2. VPN hardware or Firewall Remote Access Service Software. 
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Interface Options: Wired (Cat5), Wired (Fiber), Wireless 
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Obstructions 

 Every effort should be made to provide a “Clear line-of-sight” between the two 
wireless devices. 

 Obstructions will affect the operating distance. 

 Interference from other wireless devices will also affect the operating 
distance. 

 

 
 
 

 
 
 
 

 
 

STRUCTURE   
Absolute Max. Range 
(feet) 

Clear Glass Window  4,700 

Brick Wall   4,700 

Brick Wall next to a Metal Door  4,200 

Cinder Block Wall   4,000 

Sheetrock/Wood Frame Wall  3,300 

Sheetrock/Metal Framed Wall     2,900 

Metal Frame Clear Glass Wall   2,900 

Metal Screened Clear Glass 
Window 

2,900 

Metal Door in Office Wall 2,900 

Wired-Glass Window 2,300 

Metal Door in Brick Wall  1,500 

 

Distance 0  325’  1.2 Miles 

Wired Cat5 Cable Fiber Optic Cable 

Wireless 2.4 GHz WiFi 
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Advanced Tips 
 

Facilities with Multiple Message Centers  

Systems that are comprised of multiple message centers can use separate computers 
to control each display. It is also possible to network the system as described in 
Connecting to a Local Area Network in order to control each display from a single 
computer. The diagram below shows an example of this type of system. 
 

 
 
In this system the user would include both message centers in the project, for example 
East.ncp and West.ncp. The IP addresses of both message centers would be added to 
a table in the project configuration dialog box. The table allows you to manage the 
message centers by applying a name to each one, enable/disable each or both, and 
view the connection status of each. A shortcut to the project file can be placed on the 
desktop as described in Save Project As.  
 

 
 
 
 
 
 

IP Address = 192.168.0.210 

IP Address = 192.168.0.211 
IP Address = 192.168.0.212 

IP Address = 192.168.0.208 

IP Address = 192.168.0.209 

East West 

For the East message center; add its IP address (192.168.0.210) to the Display Connection table. An attempt is made to connect 
to the message center and the status is reported. You can now apply a name for reference. 

Do the same for the West message center; IP address (192.168.0.209). 
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Creating Advertisements  

Create each advertisement on a separate playlist. In this way, ads can be disabled 
and enabled without having to re-create the advertisement every time that you want 
it included. When an instant message is played, such as “Touchdown!” an 
interrupted advertisement will be played in its entirety from the beginning after the 
Touchdown message completes. This way an advertiser gets their entire message 
shown at the same rate and priority as other sponsors regardless of when exciting 
plays happen during the game. The figure below shows an example of a good 
project structure for managing several advertisements. 
 
 

 
 
 
 
Note: The log file can be used as a record of total cumulative run times for each 
advertiser or exact times the ads ran.
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TROUBLESHOOTING Guide 

        Problem                         Cause                                                Solution 

 

If the problem persists please contact the Nevco Service Department. 

800-851-4040

Computer hangs 
during composer 
installation 

Computer does not have 
latest updates 

Make sure all updates have been applied. 

My message will not 
display on the 
message center 

Not sent to Message 
center 

Need to click “Update Message Center” 

Check connection between computer and message 
center 

Playlist is Disabled 
Uncheck “Disabled”, set a scheduled time and date and 
click “Update Message Center” 

Playlist is an Instant 
Message Playlist 

Use “Instant Message Interface” and click on the 
messages icon to display the message instantly 

Uncheck “Instant Message Playlist”, set a scheduled time 
and date and click “Update Message Center” 

Not Scheduled 
Verify the times and dates the message is scheduled to 
be displayed 

Not Visible  Verify the Font and Background colors and Font size 

No sprites in the Sprite 
Library work area Wrong directory path 

In the main menu click Project > Configure and be sure 
the Library Path is correct. 

My long message is 
not all displayed 

Using a regular text 
string 

Click the Scrolling Text tab to open a dialog box for 
creating and configuring long scrolling text strings. 

I have trouble adjusting 
the size of the graphic 
so it will fit my 
message center 

Graphic is extremely 
large 

Use a graphics program to adjust the image to a size 
more compatible with the message center. (See “Creating 
Good Graphics” page in this manual). 

Message will not scroll 
off the display 

End of message 
Add spaces to the end of the message to force it off the 
display. 

Message Center does 
not respond or it acts 
“goofy” 

Missing HASP Key Plug your HASP Key into a USB port on your computer. 

 
My temperature is 
displaying --F 

Computer has been in 
“Hibernate” mode 

Close Composer (be sure to save your data), then, 
reopen Composer. 

Computer glitch in the 
message center 

Reset the message center (from the main menu click 
Display then from the dropdown menu select Reset). 

Computer glitch in the 
message center 
Temperature sensor not 
enabled 

Turn the power to the message center off – wait a few 
seconds – turn the power back on. Note: It may take 45 
seconds or more for the connection to be reestablished. 

Enable it by clicking Message Center > Temperature 
Interface 

Playlist preview hangs 
Too many animations for 
computer resources 

Select a sprite library that has fewer animations, before 
clicking preview button, or disable animations in project 
settings. 

My message center is 
not adjusting it’s 
brightness according to 
light conditions 

A photocell is not 
installed or the 
brightness control is not 
set to auto 

Install the hardware or enable auto brightness control by 
clicking Message Center > Brightness Interface > Auto. 
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FREQUENTLY ASKED QUESTIONS 
 

Q. How many playlists can be loaded on the message center at one time? 

A. It depends on the message center, the playlists, and their lengths and 
complexities, but usually the limit is not reached. Only one Project can be 
loaded into the Message Center at a time. All Playlists needed must be a 
member of this Project. When a new Project is sent to the Message Center it 
replaces the old Project. 

 

Q. Can more than one playlist be scheduled for the same time period? 

A. Yes, they will be displayed one after the other. 

 

Q. How can I make the message center display the date, time, and temperature? 

A. Date, Time, and Temperature are functions of the message center itself. If 
your message center includes these options, they are accessed by means of 
“TOKENS” which is simply a place holder that can be placed onto a frame. 
When the frame is displayed, the current time or temperature is substituted 
for the token. (This is an excellent way to provide a service to your patrons 
and to keep them looking your way).  

 

Q. Can more than one line of text be displayed at once? 

A. Yes, you can drag and drop more than one text sprite onto the same frame. 
Just resize each sprite so that the lines fit. 

 

Q. Can the brightness level be adjusted on the message center? 

A. Yes, from the main menu, click Message Center, select the message center 
from the list, click Brightness Interface, and make the desired settings. 
(Must be connected to message center). 

 

Q. Can the same playlist be scheduled for more than one time frame? 

A. No, but you can make a copy of the playlist, schedule the original for the first 
time frame, and schedule the copy for the second time frame. 

 

Q. Can I force a special message to be displayed quickly? 

A. Yes, it’s called an Instant Message Playlist. Select the playlist then click the 
Instant Message Playlist check box. When you are ready to send the project 
to the message center, click the Update Message Center button. Then click 
the Instant Message Interface button to open the Nevco Instant Message 
Interface. You can now click on the Playlist icon to immediately display the 
Instant Message Playlist on the message center. Any scheduled Playlist that 
is running will be interrupted and will resume from its beginning after the 
instant message has finished.
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Q. How long will an Instant Message Playlist display? 

A. There is no schedule -- so it depends on the message and the effects. 

 

Q. What happens if there is a power failure? 

A. All of the playlists are stored in non-volatile memory. The message center 
will resume displaying messages beginning with the first playlist with a 
qualifying schedule. 

 The message center internal clock maintains accuracy even during a 
power outage.  

 

Q. Can the message center produce sound? 

A. No, the X6 message center will not. However, if running direct connect or 
an X8 (remote display server), then the sound can be output of the PC 
running the display server. 

 

Q. Can the message center be operated during a rain? 

A. Yes, the message center is designed for outdoor use and can be used 
indoor or outdoor. 

 

Q. How do I set the time for the message center? 

A. In the main menu, click Message Center, click Configure Time and 
Date, make the necessary settings and click “>> SYNCHRONIZE >>”.  
Composer must be connected to message center. 

 

Q. How do I scroll a long message across the message center? 

A. From the “Message Center Controls” playlist area (far right in Composer 
interface), click the “Scrolling Text” tab to reveal a work area for entering, 
configuring, and previewing a scrolling text string.  

 

Q. Can foreign language fonts be used? 

A. Foreign language fonts can be selected and used in text items. The script 
used can be changed in the “Change Font” option. 

 

Q. How can I blank the message center? 

A. The message center will automatically blank when a playlist’s schedule 
ends.  One can also update the message center with a blank project. 

 

Q. What type of graphic files can be imported into Nevco Composer? 

A. .bmp, .gif, .jpeg, and .avi. Note: Not all .avi compressors are supported. 
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Q. What is AVI? 

A. AVI stands for Audio Video Interleave and is currently the most common 
file format for storing audio/video data on the PC. 

 

Q. What is a codec? 

A. A device or program capable of performing encoding and decoding on a 
digital data stream or signal. The word codec may be a combination of any 
of the following. ‘Compressor-Decompressor’, ‘Coder-Decoder’, or 
‘Compression-Decompression algorithm’. 

 

Q. What is VSB (Virtual Scoreboard)? 

A. Live scoreboard data displayed on a Message Center as if it were a 
scoreboard.  
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GLOSSARY 

 

 

ACCESS POINT (WIRELESS AP) 

 A hardware device that allows wireless  

 communication devices to connect to 
a  

 network. 

 

    

 

 

 

WIRELESS BRIDGE 

 A hardware device used to connect two or  

 more network segments. 

 

 

  

 

 

 

 

 

 

 

 

 

AVI 

 Audio Video Interleave - File extension for video or animations. 

 

BROWSE button  

When you see this button, you can click it to open a window that allows 
you to search the directories and files on your computer. 

 

 

ACCESS POINT 

WIRELESS BRIDGE 
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CASCAN card 

 Distributes the data inside the  

 Message Center. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DHCP 

Dynamic Host Control Protocol; Server automatically changes IP address 
periodically 

 

FIREWALL 

 Software that blocks unwanted or potentially unsecured network access 

 

FONT 

Fonts reside on your computer and can be accessed from its applications. 
Text strings that use a regular font can be resized and repositioned after 
being placed on a frame. The frame is converted into a picture (.gif) before 
it is sent to the message center. 

 

FRAME 

The frame is the basic display element of the message center. Everything 
to be displayed must be on a frame. 

HASP KEY (DONGLE) (LICENSE KEY)  

The HASP Key plugs into your computer’s USB port and acts like a 
physical key to allow or deny access to the message center. 

 

CASCAN card 
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INSTANT MESSAGE PLAYLIST 
A playlist that once sent to the message center, can be displayed instantly 
with a single mouse click from the Instant Message Interface. 

 

IP 

 Internet Protocol 

 

IT 

 Information Technology  
 

LAN 

 Local Area Network 

 

PC 

 Personal Computer 

 

PITCH 

A term used to define the distance between pixel elements of a display. 

 

PLAYLIST 

A playlist is comprised of a series of frames. Each frame contains the data 
to be displayed and instructions that tell the message center how the 
frame is to be displayed. 

Each playlist includes instructions that tell the message center when the 
Playlist should be displayed. 

There can be any number of playlists, each can contain up to 256 frames. 

 

PROJECT 

A group of playlists. A project might contain all of the playlists used by one 
person or for a particular type of event. 
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POE  

 Power Over Ethernet. 

 Used to inject power for use  

 by a device connected to the 

 Ethernet cable. 

 
 

 

 

RAS 

 Remote Access Service; Same as VPN only slower due to software 
overhead. 

 

SERVER 

 “Master” computer on network that provides various services such as 
network logon. 
 

SPRITE 

An icon likeness or representation of a text string or picture. When you 
drag and drop a sprite onto a frame a copy of the original text or graphic is 
placed on the frame. 

 

SPRITE LIBRARY 

The sprite library shows a list of words, phrases or graphics available to 
be placed on a frame. Each item includes the location on the frame that it 
will occupy. 

Display items can be divided into categories for easier sorting 

 

TOKEN 

A token is a place holder for information obtained automatically by censors 
or timers in the message center, such as temperature and time of day. 

 

 

POE 
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VPN 

Virtual Private Network; Way to tunnel over internet and be like you’re 
plugged into the LAN 

 

VSB 

Virtual Scoreboard; Live scoreboard data displayed on a Message Center 
as if it were a scoreboard 

 

VSBI 

Virtual Scoreboard 
Interface  

 

 

 

 

 

“X” MESSAGE CENTER CONTROLLER 

Defines the pixels needed to create the requested images for the 
message center display. 
Interfaces Nevco Composer with the display.

MESSAGE CENTER CONTROLLER 
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Text Message Help 
Two types of fonts are available for text messages: 

Regular font 
Text strings that use a regular font are converted into a picture 
(.gif) before being sent to the sprite library. 

The sprite can be resized and repositioned after being placed on 
a frame. 

Note: For best results, use the appropriate size font. 

Note: Foreign language fonts can be selected and used in text 
items. 

 

Embedded font (what tokens use) 
Embedded fonts have their pixel definitions stored in the message 
center. This requires less information to be sent to the message 
center than when using regular fonts.  

The number of font sizes available will depend on the size of your 
message center. 

Note: Tokens use only embedded fonts and cannot be resized on 
the message center, however, they can be repositioned horizontally 
or vertically. 

 

Long messages  

Long messages to be scrolled across the message center should be 
created and configured from the “Scrolling Text” dialog box. This dialog 
box also has a preview area so you can see how the message will look on 
the message center. 

 

Various speed settings are available. By choosing the proper speed a message 
can be scrolled across the message center smoothly. 
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System Requirements 
 

Minimum Recommended 

 

PC running at 1.4 GHz or faster 

512 megabytes (MB) of RAM 

300 megabytes (MB) of available hard disk space 

CD ROM drive 

2 Available USB ports 

Windows 7, 8 or 10 

Microsoft Internet Explorer 9 

Screen Resolution 1024 x 768 * 

 

 

PC running at 2.4 GHz or faster 

1 Gigabytes (GB) of RAM or more 

400 megabytes (MB) of available hard disk space or 
more 

CD/DVD ROM drive 

2 Available USB ports 

Windows 7, 8 or 10 

Microsoft Internet Explorer 11 

Screen Resolution 1280 x 1024 or higher * 

 

 

* Note: Higher screen resolution is desirable when using wider message centers. 
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Appendix A …… HASP Key Hardware Wizard Dialog(s) 
If your HASP key was not installed properly you can remove the HASP Key from its USB slot, 
reinstall the HASP key and use the following steps to properly install your HASP Key.  
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When properly installed, a LED on the HASP key will be lit, indicating that Nevco Composer should 
be allowed to communicate with the Message Center
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Appendix B …… Pixel Configuration Utility 
(Requires Message Center Firmware 1.81 or Later) 

 
As the Message Center ages, pixels that are used the most may become dimmer 
compared to those that are used less. Also, if a block is replaced for some reason, its 
pixels may appear brighter than the surrounding pixels. For these reasons the message 
center has the ability to adjust the intensity of each LED that makes up each pixel. This 
adjustment value is applied to each LED while it is on. The adjustment value is stored in 
the message center memory and is retained even when the power is turned off. This 
Pixel Editor provides a way to adjust these values so that all of the colors are balanced 
across the entire message center. 
 
 
Note: Be sure all playlists and scheduling has been saved before using the Pixel Editor. 
 
 
Note: If replacing one or more blocks, jot down the location (pixel count from the upper 
left corner of the message center to the upper left corner of each block) for later use. 
 
 
Note: The following procedure should only be attempted by someone experienced with 
the message center. 
 
 
Note: Before the new hardware can be used, it must be enabled. 

To enable the Message Center Hardware, do the following steps: 
 

 Open the Pixel Configuration Utility (Pixel Editor). 
 

 Click “New”. 
 

 Click “Load”. 
 

 Click “Save”. 
 
 
 
 
 
 
The Message Center can now save and use the Pixel Editor values to adjust the 
intensity of each LED in each pixel. Follow the instructions in this appendix to 
adjust the intensities as needed. 
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Note: If the message center is double sided and displays the same information on both 

sides, see the section on “Working with double sided message centers” 
later in this appendix. 
 
 
Note: For best results, it is recommended that the project be set to COLOR while the 
Pixel Editor is being used. 
 
 
 
 
To access the Pixel Editor Utility; click “Message Center” in the Nevco Composer menu 
bar, then select the message center from the list of message centers you are currently 
connected to. Next, from the drop down menu items, select “Pixel Editor.” 
 
 

 
 
 
Note: The Pixel Editor Utility is available only while connected to a message center. 
 
 
Note: The Pixel Editor Utility is not available on an X8 message center.
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Type a unique file name* and click “New” to display a representation of 
your unmodified message center and save it as a .bmp file on your 
computer’s hard drive. After editing, it will be saved again and can be recalled 
later from the dropdown list. When selected from the dropdown list, it is 
automatically loaded and ready for further editing. 
 
Note: If this is the first time using this function with this display click Load 
then Save. After this cycle the power on the display.  

 
Next indicate the “X” (horizontal) and “Y” (vertical) position of the pixel, 
or upper left corner of the group of pixels, that need to be adjusted. This is the 
pixel count from the upper left corner of the message center. The values can 
be entered manually or by clicking the mouse while hovering over the 
representation of the message center. Use the “Show Red, Green, Blue” 
buttons to flood the message center with the pure color. This will help find 
pixels that need adjusting. A check box is used in conjunction with these 
buttons to turn on an outline of the specified block of pixels being edited. The 
“Show Grid” buttons will flood the message center with color while adding a 
grid to help find pixel locations. Each grid line represents 16 pixels. By 
counting the number of grid lines across or down and multiplying by 16 the 
approximate location of the pixel in need of adjustment can be calculated. 
 
Next, set the size of the block of pixels to adjust. Use the dropdown to 
select from a list of standard block sizes, or enter the size (pixel count) 
manually. 

 
Note: The information bar shows the location of the mouse pointer and the 
color of the pixel it is pointing to on the simulation of the message center. 
 
*Always use file names that identify the message center and the side if 
double sided. (Example “Varsity Football East Side”).
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Once the pixel location and block size have been entered, click the “Edit 
Pixels” button so you can adjust the color intensity. The button will change 

to  
 
If you have pixels that are too dim and they have not been previously 
adjusted, then all the other pixels will need to be adjusted down to match 
them. Check the “Invert Selection” check box to make your adjustments 
apply to all pixels that are NOT selected. 
Use the slider bar, or enter the Red, Green, or Blue values directly. 
Note: If you are working with a previously used file, you may retrieve the 
current settings by hovering the mouse pointer over the simulated 
message center. The values will appear on the information bar at the 
bottom of the window. 

 

 
Click the “Load” button to preview the effects of your settings on the 
message center. 
If you are satisfied with the results, click the “Save” button to permanently 
save the settings in the message center and to save the file to your 
computer’s hard drive.  
If you are NOT satisfied with the result, then click the “Restore” button to 
force the message center to discard the preview values and use the most 
recently saved adjustment values. 

  
Note: To adjust another pixel or group of pixels with the same color 
settings, define the location, click the “Edit Pixels” button, then click under 
the slider for the color to be adjusted and follow the steps outlined above. 
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To check for uniformity of pixel color: 
From the Pixel Configuration window, click the red “Show Red” button. The complete 
message center will be colored with pure red.  Note any and all pixels that appear 
brighter or darker than the remaining pixels. You can turn on a grid to help identify the 
location of these pixels or blocks. If the message center is monochrome, you need only 
test the red channel, however for colored message centers the same test should also be 
performed for green and blue. 
 
 

To adjust pixels that are too bright: 
From the Pixel Configuration window, select the pixels from the model of the message 
center. First select the pixel or upper left corner of the group of pixels. Next select the 
size of the group or block of pixels.  
Note: Use the dropdown to select from a list of standard block sizes, or enter the actual 
size (pixel count). 
 
Next click the “Edit Pixels” button and select the color to be adjusted. You may adjust the 
color with the slider, or use the spinner box, or enter the RGB color value directly. Notice 
the color of the selection has changed to show the new color intensity. 
 
Click Load to send the changes to the message center for preview. If you are satisfied, 
click the “Save” button to permanently save the file to the message center’s memory and 
to your PC’s hard drive.  If you are not happy with the changes, click the “Restore” button 
to discard the changes and revert back to the most recently saved file. Make the desired 
changes and try again. 
 
 

To adjust for pixels that are too dim: 
Since pixels cannot be adjusted brighter, it is necessary to adjust all other pixels down to 
match the dimmer ones. This is easily done by using the “Inverse Selection” check box. 
The selected color will be adjusted by the amount requested and the other colors will be 
automatically adjusted to maintain white balance. 
 
From the Pixel Configuration window, select the dim pixels from the model of the 
message center. First select the pixel or upper left corner of the group of pixels. Next 
select the size of the group or block of pixels.  
Note: Use the dropdown to select from a list of standard block sizes, or enter the actual 
size (pixel count). 
 
Next click the “Edit Pixels” button and check the “Inverse Selection” check box. Select the 
color to be adjusted. You may adjust the color with the slider, or use the spinner box, or 
enter the RGB color value directly. Notice the color of the non-selected pixels has 
changed to show the new color intensity. 
 
Click Load to send the changes to the message center for preview. If you are satisfied, 
click the “Save” button to permanently save the file to the message center’s memory and 
to your PC’s hard drive. If you are not happy with the changes, click the “Restore” button 
to discard the changes and revert back to the most recently saved file. Make the desired 
changes and try again 
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Working with double sided message centers: 
Double sided message centers present a more complex problem when it comes to Pixel 
Editing. Since both sides, A and B, display the same thing, a modification to the pixel intensity 
values to side A will also be applied to the corresponding pixels on side B.  To overcome this 
problem, follow these guidelines. 
 
 
 
 
 
 
 
 
 
 
 

  

For a double sided message center: 

 Follow the preceding instructions to correct the pixel intensity for Display B. 

 Power down Display B*. 

 Repeat the same steps for Display A while Display B is powered down. 

 

* If you are unsure how to power down your message center, please contact Nevco Inc. 
Service Department. 

 

 

X6 
Controller 

Display 
A 

Display 
B 

Double sided message center 
(Block Diagram) 


